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Compatibility  
Version 4.10 of Informatik Image Driver runs under Windows 2000, XP, 2003, 2008, VISTA 

and Windows 7 – 32 bit only 
A separate Version for CITRIX is required.  
The User interface for the 32 bit and 64 bit versions are the same. The manuals are valid for 
both versions.   
The 64 bit versions require specific drivers which must be bought separately/additionally.  

For Windows NT 4 please use version 2.5; for Windows 95/98/ME use version 1.2. These 

versions are available on request (email to: mbose@expert-tools.com). 
 

Important: To run this driver on a Server, you will need to purchase the server version. The 

single user version will not run on a network as a “shared” driver.  

Introduction  
The Informatik Image Driver creates TIFF, PDF, and JPEG files from virtually any printable 

Windows document. Simply open the document (for example open a Word file in Microsoft 

Word), choose Print from the File menu, select the Informatik Image Driver 4.10 as the 

printer, press the OK button, in the Informatik Image Driver dialog window specify the output 

folder, file name and other settings, and press the OK button. This is, of course, somewhat of 

an over-simplification. Our program has several additional features and options as explained 

in this user guide.  
 

This document covers the version of the Informatik Image Driver for Windows 2000, XP, 

2003, 2008, VISTA and Windows 7 (32 and 64 bit).  
 

Before you use the program, please read the licensing terms and conditions under the 

„License, Warranties, Disclaimer‟ section. By using this program you agree to all the terms 

and conditions of the license.  

 

 

Different Software Versions  
 

Demo Version  

You may use the demo version only for the purpose of evaluating the program.  The standard 
demo version creates valid TIFF and PDF output files.  However, the output files created by 
the demo version are crippled, the small upper left corner being cropped. This crippling will of 
course not occur in the purchased version.  The standard demo version allows you to 
thoroughly test the program by printing an unlimited number of print jobs.  The share 
(network) functionality is enabled for testing purposes. 
 

Stand-alone PC version  

The stand-alone version can be installed and run on a PC or workstation (single-seat).  The 

mailto:mbose@expert-tools.com?subject=Legacy%20IID%20Driver
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driver can only be used locally on that PC. The share and WTS capabilities are disabled. 

However, output files can be saved to any folder accessible to the user, locally or on a 

network drive. The stand-alone version can also be installed on a server for a local use only 

(no sharing or remote use). Administrator rights may be required to install the software 

correctly.  

 

A single-seat software license is required for each PC or workstation on which the driver is 

installed.  
 

Server  version  

The server version is designed for comprehensive network use.  It supports remote, shared 

and local processing and is fully compatible for Windows Terminal Server (WTS). A separate 

version for Citrix is available. The driver may be shared with network users. The output files 

can be saved to the folder for which the logged-in user has WRITE permission.  
 

The appropriate server/multi-user software license must be purchased.  Installation of the 

driver on Citrix requires a special license.  
 
 

Installation  
1. If you are installing from a zip file (a compressed download file with a .zip extension), 

unzip the zip file first into a separate folder (we recommend that you create and use 

the c:\imagedriver folder).  

 

2. Before you install the Informatik Image Driver, check if you already have a previous 

version of the driver installed on your system. If you already have the Informatik Image 

Driver installed (licensed or demo, current or previous versions), you must first un-
install the driver, then restart Windows. For a clean un-install of the driver please use 

the REMPRN (remprn.exe) driver-uninstall utility. This utility should be included with all 

our driver distributions. If you do not have the REMPRN utility, please download it from 

http://www.expert-tools.com . If you would like to reset the settings to our default settings, 

please double-click the „SetInit.cmd‟ file which is included with the driver files. 

 

3. Double-click installer.exe file, select „Informatik Image Driver 4.10‟, and hit the „Install‟ 

button.  
 

4. A message will appear asking whether you want to make this driver your default 

printer. Select „Yes‟ or „No‟.  
 

5. A message on the Installer window will indicate when the setup is completed.  
 

6. Restart Windows.  
 

7. Check and make sure that the Informatik Image Driver now appears as an icon in the 

Printers and Faxes window under Control Panel. You will not find the „Informatik Image 

http://www.expert-tools.com/
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Driver‟ under the Start Menu as an icon like other applications. Our driver works like a 

printer and operates via a document‟s native program (for example Microsoft Word, 

Excel, or your own printing application).  

 

If you would like special settings (special output format, resolution, etc.), you need to enter 

your preferences in the Printer Control Panel. Generally, no special entries are required and 

you are urged not to change the default settings unless you are familiar with the driver and its 

capabilities. Later on in this text, the manual will explain how you can specify default entries in 

the Printer Control Panel.  
 

 

Tutorial  
This tutorial will create a multi-page TIFF file from any Windows document.  
 

1. Open the document that you want to convert into a single or multi-page TIFF.  For 

example, to open a Word document, launch Microsoft Word and open the document 

file from the File menu.  
 

2. Choose “Print” from the document‟s File menu. The application‟s Print dialog will be 

displayed.  
 

3. If you did not specify the driver as your default printer during the initial setup, select 

“Informatik Image Driver X.XX” (X.XX stands for the version number of your image 

driver) as your printer and hit the „OK‟ button at the bottom right of the „Print‟ box.  
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4.  The „Informatik Image Driver Dialog‟ (shown in the picture below) will pop up. If this is 

not the case, go to the „Miscellaneous Settings‟ under the „Informatik Image Driver 

Dialog and Printer Preferences‟ section of this manual and look for „Hide this Dialog‟. In 

that section you will find information on how to deal with this problem. 
 

 
 

5. In the „Output Folder‟ field, either manually type the full directory path of where you 

want to create your TIFF file (e.g. c:\documents\accounting), or click on the Browse 

button and select a folder. Do not include the file name in the „Output Folder‟ field. 

    

6. In the „Output Filename‟ field, type in the file name for your TIFF file or click on the 

Browse button and select a file to be overwritten. If you use the driver for the first time, 

the file name is defaulted to a generic file name. Simply overwrite the default-file name 

to a name of your choice.  
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7. There are several other features and options and you may experiment with them.  

They are explained in the „Informatik Image Printer Dialog and Printer Preferences‟ 

section of this manual.  
 

8. Click the „OK‟ button on the lower-right corner of the box and the TIFF file will be 

created.  

 
 

Printer Control Panel  
(Also called Informatik Image Driver Printing Preferences or Informatik Image Driver 

Document Properties)  
 

Certain special settings, like graphic format and resolution of the output file, need to be 

selected in the Printer Control Panel.  

 

The Printer Control Panel is accessed either from the Print window or via the Start menu 

(Start button at lower left corner of the screen).  

 

a) Open the Printer Control Panel via the Print window:  
 

When you select Print from the File menu, the Print window appears. Select the 

Informatik Image Driver 4.10 as the printer. Most Print windows include a Property 

button (sometimes called Preferences). Click on the Property button and the „Informatik 

Image Driver Document Properties‟ window will open.  
 

Please note that selections made via the Print window solely last for the life of the 

source file‟s application (for example Microsoft Word). When you re-launch the source 

file‟s application, the settings revert to the settings specified in the Printer Control Panel 

via the Start button (see next paragraph).  
 
 

b) Open Printer Control Panel via the Start button:  
 

Click on the Start button (lower left corner of the screen) and select „Control Panel‟. In 

the „Control Panel‟ double-click on „Printers‟ (Printers and Faxes).  Among the list of 

printers you will find the Informatik Image Driver X.XX. (X.XX stands for the version 

number of your image driver)   
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Right-click on „Informatik Image Driver‟ and select „Printing Preferences‟. The „Informatik 

Image Driver Printing Preferences‟ window appears. 

Please note that selections made in this way will be permanent. They will apply to all 

printing jobs in the future. Of course, you can always change selections again in either 

of the two ways described above.  
 

 

Informatik Image Driver X.XX Printing Preferences window:  

(X.XX stands for the version number of your image driver)   
 

Now you are in the Printing Preferences window. There are four (4) tabs:  
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 Layout  

 Paper/Quality  

 Print Output Settings  

 About  
 

In the Layout tab and the Paper/Quality tab you will only ever need to use the „Advanced…‟ 

button. Those options have to be set in the application of the source document. All setup 
entries relating to output graphics formats, TIFF compression, Resolution, and Color depth 

are specified via the „Advanced…‟ button.  
 

The Print Output Settings tab displays the Document Properties or Printing Preferences 

window that contains settings for output file names, handling options and preferences. For 

more information about this tab, see the „Informatik Image Driver Dialog and Printing 

Preferences‟ section below.  
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The About tab displays important information about the software license. 

 

In the Layout window or Paper/Quality window, always click on the „Advanced‟ button.  When 

you click on the „Advanced‟ button the Informatik Image Driver X.XX Advanced Options 

window will appear. (X.XX stands for the version number of your image driver)   

 
 

Advanced Options  

 

(Click the „Advanced…‟ button in the Layout or Paper/Quality tab)  
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Paper/Output  

Here you can set the output size of the paper. Be aware that if a program has its own 

custom/default paper size, it will always overwrite the paper size chosen in the „Informatik 

Image Driver Advanced Options‟. 
 

Graphic 

 Resolution: Here you can select the resolution of the output image. If you would like a 

resolution not specified here, please see the „Customization‟ section.   
 

Please note that if you select a resolution of 200x200 for the TIFF F-Class, the driver 
will actually create a file with a resolution of 204x196. 
In order to minimize the size of the output files, select the smallest possible resolution 
(200 dpi is usually a good choice) for resolution.  

 

 Scaling: Always leave at 100%.  
 

Document Options 

 Format: Here you can specify the format of the output-file format (black/white and 

colored TIFF or JPEG and compression methods). The default setting is TIFF Group 4 

Single-Strip, the most commonly used TIFF format, but there are several other options 

that you can use.  
 

Important:  
JPEG files are high-quality-color images and only support single-page files. In the 
„Informatik Image Driver Dialog‟ (see next section), specify the output file with a .tif 
extension. The actual output file will have a .jpg extension. If you want to convert a 
multi-page file to JPEG, always use „Serialization‟ in the „Informatik Image Driver 
Dialog‟. In this case, the first page will become a JPEG file with the specified output-file 
name and subsequent pages will be named with a _1, _2, etc. suffix. Please note that 
JPEG conversions take more time than TIFF conversions and should mainly be used 
for photo-type images rather than black/white-text documents. 
 
The „TIFF 4-bit (16 Colors) Packbits‟ and „8-bit (256 Colors) Packbits‟ formats are only 
suitable for solid color images such as charts. Photo images should instead be 
converted to either „JPEG‟ or „TIFF 24-bit Color Packbits‟. 
 
The processing of colored documents requires more memory to process than a 
black/white document. Thus, if your computer does not have a sufficient amount of 
memory ready, the driver will automatically revert to black/white processing. 
 
Fax applications generally require the „TIFF-F Class‟ format. Old fax applications may 
use the „TIFF F-Class Reverse Fill‟ format. For the „TIFF-F Class‟ you must use a 
resolution of 200x200.  

 

 Halftone Color Adjustment: Do not use/change this option.  
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Informatik Image Driver Dialog and Printer Preferences  
When you press the „OK‟ button in the Print window (File | Print) of any printable document, 
the „Informatik Image Driver Dialog‟ will be displayed (unless you previously checked the 

„Hide this Dialog‟ checkbox). If the dialog is hidden, you can uncheck the „Hide this Dialog‟ 

checkbox in the Print Output Settings (see „Printer Control Panel‟ section).  
 
If you would like to create default settings for all the print jobs and would not like the 
„Informatik Image Driver Dialog‟ to pop up every time you print a document, you can make 
permanent changes to the settings under the Control Panel (see „Open Printer Control Panel 
via the Start button‟ in the „Printer Control Panel‟ section) and then check „Hide this Dialog‟ 
under the „Print Output Settings‟ tab.  
 

The Informatik Image Driver dialog has the following settings and options:  
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Output Mode 

Document Mode  

This mode creates multi-page TIFF files. For example, if your source file is a 10-page 

document, the driver will create a 10-page multi-page TIFF file (one single file with 10 pages).  
 

Append Mode  

This mode will cause the output file to be appended to an existing file. If you process a 5-page 

source file and save it to a TIFF file that already has 3 pages, the driver will add the 5 new 
pages to the existing TIFF file, so that the new file will be a TIFF file consisting of 8 pages.  If 

the specified output file name does not exist, „Append Mode‟ behaves like „Document Mode‟.  

 

Important: The settings in this mode must be made before appending. Append only to TIFF 

files created with the „Informatik Image Driver‟ (you can also append to certain standard-TIFF 

files created with other software, but please verify the result and always make sure that you 

have backed up the original file). This option is not available when in „PDF-Output Mode‟.  
 

Serialization Mode  

This mode outputs the pages of a multi-page source file as individual files with a user 
specified prefix (Serial Prefix) followed by a numeric suffix (selected as Initial Serial Number). 

For example, a 3-page source file saved as file SAMPLE (Serial Prefix) will create three files 

called SAMPLE0001.tif, SAMPLE0002.tif, and SAMPLE0003.tif.  The number of leading zeros 
in the suffix number is specified in the „Select Number of Digits to Use in Serialized File 

Name’ (2 to 8).  
 
If „Reset after each Job‟ is checked, the serial number will be reset to 0001 for each print job.  
 
If the „Reset after each Job‟ is unchecked, the serialization numbering will be continuous. To 

reset the Initial Serial Number to 0001 click on the Reset…button.  
 
 

Output Selection  

When you use the driver for the first time, the driver defaults to generic output names.  Click 

on the „Browse‟ buttons to select/specify the Output Folder and the Output Filename. Your 
selections will become the default for the next print job. If no default output folder is specified 

the driver will use the system‟s TEMP file instead.  
 

Note that the Folder Name should not have an ending back-slash (\). If the file name does not 

have an extension, a .tif (or .pdf) extension will be added automatically. If you want to create a 

file without an extension, use a period (.) after the file name. You can also output the files to a 

network drive. If you run the driver in a batch mode, the folder and file name can be specified 

in the Windows Registry (see „Windows Registry‟ section).  

In „Serialization Mode‟, the „Output Filename‟ field is used for the „Prefix‟ of the filename. Do 

not use an extension name in the „Prefix‟ field.  
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Auto-numbering and auto-naming are explained in the next section. For batch processing, 

please review the „Batch Processing‟ and „Windows Registry‟ sections.  
 
 

Miscellaneous Settings   

Some of the options are disabled if the driver is set to Append mode.  
 

Auto-Numbering of Output File  

If this option is checked, the output files are named by specified „Filename Prefix‟ 

concatenated with an automatically incrementing suffix.  For example, if the Filename Prefix is 

SALES, the output files will be named SALES0001.tif, SALES0002.tif, SALES0003.tif, etc. 

Each print job increases the serial number by 1. This is not to be confused with „Serialization‟ 

which serializes the pages of a multi-page file, whereas „Auto-Numbering‟ numbers the output 

files (and output files can be multi-page file/s). The auto-number suffix can be reset to zero by 
clicking on the Reset File# button.  

If a prefix is not specified, the output file name will consist of the auto-incrementing number 

only, e.g. 0001.tif. 
 

Use Source Document Name for Output  

If this option is checked, the name of the output file will be the same as the name of the 

source file (with a substituted extension name). Some programs may add the application 

name as a prefix, which is a problem for the „Use Source Document Name for Output‟ option.  
If the Trim Source Name option is checked, however, the leading string of the passed source 

name (up to the right-most encountered space in the source name) will be cut off. This option 

is useful to trim the application name, which - as stated before – may be included with the 

source-file name by some applications (for example Microsoft Word).  
 

Always Overwrite  

This option is unchecked by default. The driver will alert the user if the specified file name 

already exists. If the „Always Overwrite‟ option is checked, an existing file will be overwritten 

without a warning.  
 

Hide this Dialog  

If this option is checked, the dialog will not be displayed when printing a document. Hiding the 

dialog is mainly useful for auto-numbering of files and for batch processing. To re-display the 

dialog when printing a document, the „Hide Print Dialog‟ in the „Print Output Settings‟ tab 

should be unchecked (see Printer Control Panel section)  
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PDF Output  

If this option is checked, the output file will be a PDF instead of a TIFF file. However, be 

aware that the PDF will consist of an embedded TIFF of the format specified under the 

„Advanced…‟ tab of the „Informatik Image Driver Dialog‟. Thus, the PDF will not be searchable 

for text. 

Furthermore, the output file will always have a .pdf extension no matter what file name it was 

given (unless the file name ends with a period (.), in which case a file without an extension will 

be created).  
 
If this option is not checked, a TIFF file will be created, even if the, by you or by default, 
specified file name has a .pdf extension. This means that the program will automatically 
create a .tif extension. 
 

If the source document is in color and you would like the output files to be in color as well, 

make sure that a valid option is selected under the „Advanced…‟ tab of the „Informatik Image 

Driver Dialog‟. If you select a B/W (Black/White) option, the PDF-output file will be 

black/white. 
 

Select Application to be Launched  

When you create the TIFF file, you can cause „Informatik Image Driver‟ to automatically 

launch another application, passing the output-file name as a parameter. For example, you 

may want a viewer to display the TIFF file after it has been created. To open the TIFF file in 

the viewer, and supposing the viewer is VIEWER.EXE and is situated in C:\windows, type in, 

for example,  “c:\windows\viewer.exe” or you can use the „…‟ button to browse and select the 

viewer.exe program. If you add a parameter, the driver will pass both the specified parameter 

and the output file name to the application (in that order, separated by a space). It is up to the 

application to parse and use the parameter string. In most cases a parameter is not required. 

A very good example can be found in our FAQ:  

http://www.expert-tools.com/FAQ/cache/15.html 
 
 
 

Window Registry  
The default output-folder name, output-file name, and other settings are saved in the 

Windows Registry under HKEY_CURRENT_USER\Software\HSM\X.XX\Settings.  
X.XX indicates the actual version of your Informatik Image Driver  

 

For batch processing, you can set the folder name programmatically with standard API 

functions.  
 

Warning:  Be advised that the Windows Registry is the backbone of Windows. If you make 

bad changes to the registry you could „destroy‟ Windows or other programs. If you decide to 

make changes to the registry, please create a backup of your computer system ahead of 

time.  

http://www.expert-tools.com/FAQ/cache/15.html
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Job and Pages Counter  
The cumulative number of pages and the number of pages of the last print job are stored in 

the Windows Registry (see Windows Registry section above). This feature is useful if you run 

the driver within an application and you need to know when a print job is completed and how 

many pages have been created. The „Informatik Image Driver‟ also creates a zero-size 

DONE_HSM.TIF file at the end of each print job (see next section).  
 
 

DONE_HSM.TIF Sentinel File  
The „Informatik Image Driver‟ creates a zero-size DONE_HSM.TIF file at the end of each print 

job, which is useful for determining when a print job has been completed.  
 

When a new print job is requested, the driver first deletes the old DONE file and then creates 

a new DONE file when the print job is completed. For a multi-page/serialized file, the DONE 

file is created only when the last page has been saved.  
 

The location of the DONE_HSM.TIF is the directory of the TEMP environment variable. To 

see the directory name of the Sentinel file, type „Set‟ in the DOS Command Prompt and press 

Enter, or simply have your application return the TEMP environment variable. This variable 

can also be changed in Windows under „System Properties / Advanced / Environment 

Variables‟. 
 
 

Network Installations  
You may install our driver on single-user PCs, workstations, and servers (including Windows 

Terminal Servers and Citrix). However, a server license is required if the driver is shared or a 

special version for Citrix networks.  Prices are subject to change; please contact HSM 

Informatik AG or visit us on the web (http://www.expert-tools.com).  
 

If you plan to install the driver on a server as shared printer, please ensure that you obtained 

the server version and license for the correct number of workstations/terminals. Expert 

knowledge in server and network setup and operation is required.  
 

If you plan to use the „Informatik Image Driver‟ on a network, it is recommended, for optimum 

performance and for ease of installation and operation, that  you install the driver on each 

workstation (a license is required for each workstation). The footprint of the driver is only 

about half a megabyte and it installs in a few seconds.  
 
  
 
 

http://www.expert-tools.com/
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Batch Processing  
Some document types are ideal for batch processing. For example, MS Word documents can 

be processed in a batch mode, programmatically, using the exposed objects of Word (OLE 

Automation).  

 

Batch processing can take advantage of entries in the Windows Registry and use the 

DONE_HSM.TIF sentinel file.  See also the Windows Registry and the DONE_HSM.TIF 

Sentinel sections in this manual.  
 
Sample code can be found at  
http://www.expert-tools.com/ENGLISH/samples.html#iid 
Please check from time to time.  
 
 

Script Add-ons, Customizations, Other Software  
HSM Informatik AG has been specializing in graphic-format conversions and printer drivers 

for years.  For special add-on scripts with additional features (special file naming, format 

conversions, text annotations, watermarks, special output-graphic formats, etc.), other special 

requirements (silent installations, additional resolution choices, e-mail features, and other 

customizations to the driver or solutions for your specific needs ), and other programs such as 

Textlog-text extraction, TIFF2PDF, PDF2TIFF, PNG conversions, and Tiff-Tag utilities, please 

contact HSM Informatik AG: 

 
HSM Informatik AG (Switzerland) http://www.expert-tools.com 

 

 

Technical Support  
For technical support, please contact us at support@hsm.ch. 
Please understand that we can only provide support to purchasers of our products. Support to 
demo users, especially programming help, is restricted. 
 
 

Copyright  
All Rights Reserved. Copyright 1996-2010 HSM Informatik AG.  

Informatik Image Driver is a trademark of HSM Informatik AG.  
 
 

License, Warranties, Disclaimer  
For license-fee information of the „Informatik Image Driver‟ and related products, 
please visit http://www.expert-tools.com   .  

http://www.expert-tools.com/ENGLISH/samples.html#iid
http://www.hsm.ch/
mailto:support@hsm.ch
http://www.expert-tools.com/
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The software is supplied AS IS without any liabilities, direct or indirect, by the developer, 

distributor or agent. It is illegal to use the software after the trial period without obtaining a 

valid software license. The software may only be installed on the PC and type of system for 

which a valid license has been obtained. For a full text of the license terms and conditions  

see License Agreement below.  
 

Please read this License Agreement carefully before you install and use the software. By 

installing and using the software you agree with the terms and conditions of this License 

Agreement. If you do not agree with the terms and conditions you must uninstall the software.  
 

License Agreement  
This License Agreement ("Agreement") is a legal agreement between HSM Informatik AG, 

Lucerne, Switzerland ("Licensor") and you, the user ("Licensee"), and becomes effective on 

the day the Licensee installs the software.  This Agreement covers all materials associated 

with this software, including, without limitation, the downloadable files, printed and online 

documentation, and any additional supporting files and programs (herein, the "Software").  
 

1. GRANT OF LICENSE  

Licensor hereby grants to you, and you accept, a nonexclusive license to use the Software on 

a specified number of computers/workstations owned, leased, or otherwise controlled by you 

for personal or business purposes, and only as authorized in this License Agreement.  The 

Software may not be used on other computers, nor may it be used by, or transferred to, other 

computers over a network. Unless the Licensee purchased a server license, the Software 

may not be installed on a server, or on a PC/workstation that acts as a server.  Hosting a 
batch service on a server, PC or workstation requires a server version. A site license permits 

the installation of the Software on an unlimited number of PC/workstations at one site for the 

enterprise, including a server. A special developer‟s license allows the Software to be 

distributed with and for exclusive use with the specified single application; the Software must 

represent a minor part of that application, and the application must not be a web-based 

application.  
 

2. LICENSOR'S RIGHTS 

Licensee acknowledges and agrees that the Software is proprietary to Licensor and protected 

under international copyright law. Licensee further acknowledges and agrees that all rights, 

title, and interests in and to the Software, including associated intellectual property rights, are 

and shall remain with Licensor. The License Agreement does not convey to Licensee an 

interest in or to the Software, but only a limited right of use that may be revoked in 
accordance with the terms of this License Agreement.  
 

3. OTHER RESTRICTIONS 

Licensee agrees to make no more than one (1) back-up copy of the Software. Licensee 

agrees not to assign, sublicense, transfer, pledge, lease, rent, or share the rights assigned 

under this License Agreement. Licensee agrees not to reverse engineer, reverse assemble, 

reverse compile, or otherwise translate the Software.  
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4. TERMS 

This License Agreement is effective when Licensee installs the Software and shall terminate 

only if the terms of this License Agreement are broken. Licensee agrees to destroy the 

Software upon termination of this License Agreement.  
 

5. NO WARRANTY; LIMITATION OF LIABILITY 

LICENSEE ACKNOWLEDGES THAT THE SOFTWARE IS PROVIDED ON AN "AS IS" 

BASIS WITHOUT WARRANTY OF ANY KIND. LICENSOR, DISTRIBUTORS OR AGENTS 

MAKE NO REPRESENTATIONS OR WARRANTIES REGARDING THE USE OR 

PERFORMANCE OF THE SOFTWARE. LICENSOR, DISTRIBUTORS and AGENTS 

EXPRESSLY DISCLAIM THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 

A PARTICULAR PURPOSE. LICENSOR, DISTRIBUTOR OR AGENT SHALL HAVE NO 

LIABILITY TO LICENSEE OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE CAUSED, 

DIRECTLY OR INDIRECTLY, BY THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO, 

ANY INTERRUPTION OF SERVICES, LOSS OF BUSINESS, LOSS OF DATA OR SPECIAL, 

CONSEQUENTIAL OR INCIDENTAL AMAGES.  
 

 

6. GOVERNING LAW 

 

The legal jurisdiction of this License Agreement shall be Lucerne, Switzerland.  
 
 
 

HSM Informatik AG Warranty  
for the Informatik Image Driver Version 4.10, January 2010 
 

All reported errors or printing problems will be corrected within the year of warranty under the 

following conditions:  
 

1. The error must be reproducible  

2. The application in which the error occurs must have been released at the time of the 

driver release.  
 

Please report problems as follows:  

1. Description of the error  

2. Send the document  

3. The outputted TIFF file  

4. Should the error occur with a non-standard application, please send the application, if 

possible.  
 

All reported errors or problems will be answered within 5 working days. We will comment if 

the error is due to  

1. System 

2. Application 

3. User 

4. Driver 
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If we can confirm that the error is due to a driver bug, the error will be corrected within a 

suitable period of time. 
 


